
iv  Table of Contents

Table of Contents

Preface ix

UNIT 1: THE BIG PICTURE

Overview Chapter 1:  
Introducing Microsoft Office and Using 
Common Features

Introduction to Microsoft Office 2
What Devices Will Microsoft Office Work With? 2
What Storage Does Microsoft Office Provide? 2
Which Microsoft Office Should I Use? 2
What Are the Microsoft Office Apps? 3
The Lock Screen and Signing In 4

Common Features in Microsoft Office Apps 5
The Ribbon 5
The Quick Access Toolbar 5
Common Features on the File Tab 6
Common Features on the Home Tab 9
Common Features on the Review Tab 15
Other Common Features 17

UNIT 2: MICROSOFT WORD

Word 2016 Chapter 1:  
Creating and Editing Business Documents

Elements of a Professional Business Letter 22
Navigating in a Document 23

Navigating with the Scroll Bar 23
Keyboard Navigation Tips 24

Entering Text 25
Showing and Hiding Formatting Marks 25
Spacing in Letters 26
Aligning Text Horizontally and Vertically 29

Selecting Text 30
Using Numbered and Bulleted Lists 32
Editing Text 34
Creating an Envelope 35
Working with Views 36

Saving Your Work in a Different Format 38
Document Files 38
PDF Files 38
Saving a Document for ATS Analysis 38

Working with Print and Print Preview 40
Reinforce Your Skills 41
Apply Your Skills 48
Extend Your Skills 52

Word 2016 Chapter 2:  
Creating a Résumé in a Table

Introducing Tables 54
Navigating and Selecting Data in a Table 55

Modifying a Table 56
Inserting Rows and Columns 56
Merging/Splitting Cells and Aligning Data 57
Sizing Columns and Rows 59

Formatting with Borders, Shading, and Styles 61
Sorting Data in a Table 63
Using Templates 64

Saving Personal Templates 65
Reinforce Your Skills 67
Apply Your Skills 73
Extend Your Skills 76

Word 2016 Chapter 3:  
Creating a Promotional Brochure

Working with Shapes 78
Adding Text and Formatting Shapes 81

Using WordArt and Inserting Pictures 82
Aligning Objects 82

Using Text Boxes and Page Setup Options 84
Page Setup Options 84

Working with SmartArt 85
Inserting SmartArt Text and Modifying an Image 86
Changing a SmartArt Style 88

Formatting the Page Background 89
Adding Page Colors and Page Borders 89

Reinforce Your Skills 91
Apply Your Skills 98
Extend Your Skills 102

BAF-2016-KeyApps.indb   4 6/3/2016   1:48:04 PM

Building a Foundation with Microsoft Office 2016: Key Applications



 Table of Contents v

Word 2016 Chapter 4:  
Creating Reports

Creating a Business Report 104
Setting Margins 104
Indenting Text 104

Setting Custom Tab Stops 106
Using the Ruler to Set Custom Tabs 106
Using the Tabs Dialog Box to Set Custom Tabs 106

Formatting Text with Styles 108
Types of Styles 109
Collapsing Heading Topics 109

Inserting Headers/Footers and Comments 110
Arranging Text in Multiple Columns 112

Column Breaks and Section Breaks 112
Writing a Research Paper 114

Working with Footnotes, Endnotes, and Citations 114
Editing and Formatting Footnotes and Citations 118

Working with Bibliographies 120
Inserting Captions and a Table of Figures 121

Inserting a Table of Figures 123
Using Track Changes 124

Reviewing Tracked Changes 124
Reinforce Your Skills 125
Apply Your Skills 134
Extend Your Skills 141

UNIT 3: MICROSOFT EXCEL

Excel 2016 Chapter 1:  
Tracking Customer Data

Introducing Excel 144
What Is a Worksheet? 144
Cell Ranges 145

Entering and Editing Data 145
Completing Cell Entries 146
Navigating Around a Worksheet 146

Adjust Column Width and Row Height 149
Formatting Cells 150

Borders and Fill 150
Cell Alignment 152
Clear Formatting and Clear All 153

Working with Numbers and Dates 153
Negative Numbers 154
Date Entries 155

Enter a Series Using AutoFill 156
Perform Worksheet Calculations 157

Mathematical Operators 157
BEDMAS 157
Cell References 158

Print a Worksheet 160
Reinforce Your Skills 162
Apply Your Skills 165
Extend Your Skills 168

Excel 2016 Chapter 2:  
Recording Student Grades

Rearrange Data on a Worksheet 170
Insert and Delete Rows, Columns, and Cells 170
Hide and Unhide Rows and Columns 171
Sort Data by Column 172

Managing Multiple Worksheets 172
Insert and Delete Worksheets 172
Rename Worksheets 173
Move a Worksheet 174
Change the Worksheet Tab Color 174
Hide a Worksheet 174
Create a Cell Reference to Another Worksheet 175
Create a Copy of a Worksheet 177
Edit Multiple Sheets at One Time 177

Using Functions in Formulas 178
Use the AutoSum Feature 179
Sum, Average, Count, Max, and Min 179
Use Insert Function 179

Understanding Relative and Absolute Cell References 181
Absolute Cell References 182
Mixed Cell References 182
Display and Print Formulas 182

Define Names for Cells and Ranges 185
Use a Cell Name in a Formula 186

Reinforce Your Skills 188
Apply Your Skills 192
Extend Your Skills 195

Excel 2016 Chapter 3:  
Data Visualization and Images

Create Charts to Compare Data 198
Choosing a Chart Type 198
Selecting Chart Data 200
Chart Elements 201

Working with Chart Tools 202
Chart Design Tools 202
Chart Format Tools 204

Move and Size Charts 206
Edit Chart Data 207
Add Images to a Worksheet 208
Use Conditional Formatting 210
Reinforce Your Skills 213
Apply Your Skills 216
Extend Your Skills 218

BAF-2016-KeyApps.indb   5 6/3/2016   1:48:04 PM

Building a Foundation with Microsoft Office 2016: Key Applications



vi  Table of Contents

Excel 2016 Chapter 4:  
Organizing Large Amounts of Data

Starting with a Template 220
Importing and Exporting Data 221
Adjust View Options for Large Worksheets 223

Freeze Panes 223
Split a Window 223
Change the Workbook View 224

Sort and Filter to Organize Data 225
Sort Data 225
Filter Data 226

Perform Advanced Calculations 229
The IF Function 229

Controlling Data Entry with Data Validation 232
Printing Options for Large Worksheets 234

Add a Header or Footer 235
Create Tables 238
Reinforce Your Skills 240
Apply Your Skills 243
Extend Your Skills 245

UNIT 4: MICROSOFT POWERPOINT

PowerPoint 2016 Chapter 1:  
Creating and Delivering a Presentation

Getting Started with PowerPoint 248
Navigating the PowerPoint Window 248
Inserting Text 248

Using Document Themes 249
Choosing a Theme 250
Choosing Slide Sizes 251

Creating a Basic Presentation 253
Adding Slides 253
Bulleted Lists 254
Choosing the Slide Layout 256
Aligning Text 257

Delivering the Slide Show 259
Navigating Through a Slide Show 259

Reinforce Your Skills 262
Apply Your Skills 266
Extend Your Skills 269

PowerPoint 2016 Chapter 2:  
Designing and Printing the Presentation

Working with Slides 272
Copying Text and Objects 272

Working with Outlines 273
The Outline Panel 273
Collapsing and Expanding Slides 275
Deleting Slides 277

Working with Word Integration 278
Creating a Presentation Outline in Word 278

Formatting Your Presentation 281
Formatting Text 281
Setting Line Spacing 283
Setting Paragraph Alignment 284

Using the Slide Sorter 285
Organizing with Sections 286

Managing Sections 287
Printing Your Presentation 288

The Print Shortcut 289
Printing Handouts 289
Handout Masters 290
Handout Headers and Footers 291
Slide Footers 292
Printing Transparencies 293

Reinforce Your Skills 294
Apply Your Skills 299
Extend Your Skills 304

PowerPoint 2016 Chapter 3:  
Adding Graphics, Animation, and Sound

Working with Online Pictures 306
Using Text and Object Layouts 307
Deleting Placeholder Text 307
Searching for Pictures with the Insert Pictures 

Search Window 309
Moving, Sizing, and Rotating Objects 310
Stacking Objects 310
Formatting Pictures 312

Adding Other Graphics 313
Removing a Background 313
Applying Artistic Effects 317
Inserting a Screenshot 318
Working with Shapes 318

Working with Slide Transitions 322
Creating Transitions in Slide Sorter View 322

Using Slide Animation 323
Setting Animation Options 323
Using the Animation Pane 324

Adding Sound Effects 326
Reinforce Your Skills 328
Apply Your Skills 335
Extend Your Skills 339

BAF-2016-KeyApps.indb   6 6/3/2016   1:48:04 PM

Building a Foundation with Microsoft Office 2016: Key Applications



 Table of Contents vii

PowerPoint 2016 Chapter 4:  
Adding Multimedia to Presentations

Working with Multimedia 342
Types of Multimedia 342
Linked Media Files 342
Organizing Media with Subfolders 343

Using Audio in Presentations 344
Audio File Types 344
Adding Audio to a Presentation 344
Inserting and Linking 345
Acquiring More Audio 346
Choosing an Audio File Format 346
Configuring Audio Options 347
Configuring Audio Styles 347
Linking Audio 348

Creating Slide Show Timings 351
Determining Slide Timings 351
Rehearsing Timings 351

Using Video in Presentations 353
Using Online Videos 353
Using Video from Your Computer 353
Using Screen Recordings 354
Video File Formats 354
Codecs 354
Editing Videos 355
Applying Video Effects 356
Setting Video Options 358

Reinforce Your Skills 360
Apply Your Skills 366
Extend Your Skills 369

Glossary 371
Index 377

BAF-2016-KeyApps.indb   7 6/3/2016   1:48:04 PM

Building a Foundation with Microsoft Office 2016: Key Applications



iii

Table of Contents

Preface v

Chapter 1:  
Hardware Essentials

The Purpose of Hardware 2
Internal and External Hardware 2

Inputting Data 3
Core Input Devices 3
Other Input Devices 3

Outputting Information 5
Visual Output 5
Projectors 7
Printers 7
Common Technologies 7
Other Technologies 9
Dual Function 9

Processing Data 10
Processing Hardware 10
Processor Types 11

Storing Data 12
Permanent Storage 12
Temporary Storage 14
Hard Drive Characteristics 15
Identifying Permanent Storage Devices on a Computer 15
Network Storage 17
Cloud Storage 17

Purchasing Technology Wisely 18
Permanent Storage 18
Memory 18
CPU 18
Display 19
Drivers 19

Learn More 21

Chapter 2:  
Computer Software

Using Computer Software 24
Operating Systems 24
Staying Up to Date 24

Using Programs 26
Program Types 26

Managing Software 26
Installing Software 27
Updating Software 27
Repairing Software 27
Uninstalling Software 27
Customizing Software 27

Personal Computer Interfaces 28
Desktop 28
Starting Programs 28

Controlling Program and Folder Windows 29
Hiding, Showing, and Closing Windows 29
Sizing and Moving Windows 30

Learn More 32

Chapter 3:  
Networking and the Internet

Our Networked World 40
Types of Networks 40

The Internet 41
The World Wide Web 41
Other Services on the Internet 41
Browsers and Other Internet Tools 41
Domains 42
How to Connect 44

Web Browser Features 44
Address Bar 44
Tabbed Windows 45
Bookmarks and Favorites 46
Forms 48

Troubleshooting 50
Hardware vs. Software 50
Verify Your IP Address 51
Verify Your Internet Connection 51
Determine Your Connection Speed 52
Network Security 53

Digital Citizen: Performing Effective Online Searches 53
Learn More 54

YDF.indb   3 2/22/2017   12:49:45 PM

Your Digital Foundation



iv  Table of Contents

Chapter 4:  
Organizing Information

Organizing Information on Your Computer 60
Files, Folders, and Subfolders 60
Folders for Information Organization 60

Naming Files and Folders 60
Naming Conventions for Files and Folders 60
Good Practices for Naming Files and Folders 60
Symbols to Avoid in Filenames 62
Digital Citizen: Following Naming Conventions at  

School or Work 62
File Types and Extensions 63

Overview of File Extensions 63
Viewing File Extensions 64
File Types and Their Association with Programs 64

Viewing Information 66
The File Explorer Window 66
Controlling the View 67
The Navigation Pane 71
The Information Path 72

Common Storage Locations for Files 74
Default Storage Locations in Windows 74
Digital Citizen: Respecting Other People’s Files 76

Learn More 77

Chapter 5:  
Files and Folder Management

Working with Folders 82
Creating and Naming Folders 82
Copying and Moving Folders 83

Working with Files 84
Where to Store Files 84
Protecting Information 85
The Save As Dialog Box 87
Opening and Closing Files 88
Downloading Files 91
Organizing Files 93

Compressing Files and Folders 98
Archives 98
Compressed Archives 98
Compressed Formats 98
Decompressing Archives 99

Learn More 101

Chapter 6:  
Locating Information

Searching for Files and Applications 106
Integrated Search Feature 106
Searching from a Folder 106

Searching for Information Online 108
Common Search Engines 109
Effective Search Strings 109
Google Search Returns 109

Intellectual Property 110
Intellectual Property Protections 110
Plagiarism 111
Copyrighted Material 111
Free to Use 111

Learn More 113

Chapter 7:  
Cloud Storage

Backing Up Information 116
What Is a Backup? 116
Backup Solutions 116
Backup Software 118
Recovery 118

Cloud Storage 119
Benefits and Drawbacks of Cloud Storage Software 119
OneDrive 120

Learn More 124

Glossary 127
Index 131

YDF.indb   4 2/22/2017   12:49:45 PM

Your Digital Foundation




